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NEW QUESTION 1
- (Topic 3)
A user is complaining that they are seeing a blank page, when they click Create New, from your custom Inventory application. You have confirmed that they can
see the Inventory application, and the Create New module on the application navigator. What could be the cause of this issue?

A. Create New module has a broken link
B. Known intermittent issue with U115
C. User should be using Chrome instead of Explorer for their browser
D. User has read role, but not the write role on the Inventory table
E. User session has timed out

Answer: D

NEW QUESTION 2
- (Topic 3)

Which path would you take to access the table configuration page from a form?

A. The Form Context menu > View > Table
B. The Form Context menu > Configure > Table
C. The Form Context menu > Configure > Dictionary
D. The Form Context menu > View > Show Table

Answer: B

NEW QUESTION 3
- (Topic 3)
What tool is used to import data from various data sources, and map that data into ServiceMow tables?

A. Import Set
B. Update Set
C. Data Pack
D. Transform Set

Answer: A

NEW QUESTION 4
- (Topic 3)
While showing a customer their incident form, they ask to change the Priority field title to display their internal terminology PValue. How would you do that? Choose
2 answers

A. Right click on Priority and select Configure Dictionary
B. Right click on Priority and select Configure Display Settings
C. Right click on Priority and select Configure Label
D. Right click on Priority and select Configure Column
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Answer: AC

NEW QUESTION 5
- (Topic 3)
When a custom table is created, which access control rules are automatically created? Choose 4 answers

A. delete
B. create
C. execute
D. read
E. update
F. write

Answer: ABDF

NEW QUESTION 6
- (Topic 3)
Which type of ServiceNow script runs on the web browser?

A. Server script
B. Local script
C. Database script
D. Client script

Answer: D

NEW QUESTION 7
- (Topic 3)
Which type of scripts nun in the browser?

A. Script include Scripts
B. Business Rule Scripts
C. Access Contra! Scripts
D. Ul Policies and Client Scripts

Answer: D

NEW QUESTION 8
- (Topic 3)
Which field (or fields) is used as a unique key during imports?

A. Match Fields
B. Coalesce Fields
C. Key Fields
D. Sys IDs

Answer: B

Explanation: 
Reference: https://developer.servicenow.com/dev.do#!/learn/learning-plans/quebec/new_to_servicenow/app_store_learnv2_importingdata_quebec_coalescing

NEW QUESTION 9
- (Topic 3)
What role enables someone to authorize a request, with no other permissions on the platform?

A. Approver [approver-user]
B. Authorize [authorize-user]
C. Reviewer [reviewer_user]
D. Approver Group [approval_group]
E. Verification [verify_user]

Answer: A

NEW QUESTION 10
- (Topic 3)
The customer has asked that your change the default layout of the task list.
* Number
* Task Type
* Parent
* Short Description
* Assignment Group
* Assignment
* Updated
After navigation to the list, where would you click, to meet this requirement?

A. Right click on any column header, Context menu > Configure > List Layout
B. Right click List Gear icon > Configure > Columns
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C. Click List Context Menu >Personalize List
D. Click List Context Menu > Configure Columns

Answer: B

NEW QUESTION 10
- (Topic 3)
The Report Designer contains different section for configuring your report. Which section is used to specify the name of the report, and the table or data source for
the report.

A. Properties
B. Data
C. Configure
D. Type
E. Sources

Answer: C

NEW QUESTION 12
- (Topic 3)
‘Your customer has a Human Resources knowledge base, which is only accessible to members of the Human Resources department. A new procedure regarding
employee quarterly reviews needs to be published to the quarterly review category of the HR knowledge base, but should only be visible for HR managers. How
would you meet this requirement?

A. On the Knowledge Base, add User Criteria with a Manager Can Read script to the Can Read list, publish article to any category
B. Add User Criteria for HR Manager Group on the Category’s Can Read list
C. On the Knowledge Article, add an Access Control for HR Manager Group on the Can Read list, then publish article to any category.
D. Add User Criteria for HR Manager Group on the Can Read list of the article

Answer: B

NEW QUESTION 14
- (Topic 3)
When using the Data Pill Picker, use which keys to dot-walk (6 fields in other tables?

A. Arrows
B. Plus, Minus
C. Ctrl c, Ctrl
D. Ctrl <, Ctrl >
E. Shift F4, Shit FS

Answer: A

NEW QUESTION 16
- (Topic 3)
Here is an example of the criteria set for a knowledge base:
* Companies: ACME North America
* Department: HR
* Groups: ACME Manager
* Match All: Yes
In this example, what users would have access to this knowledge base?

A. Members of the ACME manager group, who are also members of HR Department and part of the ACME North America
B. Employees of ACME North America, who are members of HR Department or the ACME Manager group
C. Users which are members of either ACME North America, or HR Department, or ACME Manager Group
D. Member of the ACME Manager group, and HR department, regardless of geography

Answer: A

NEW QUESTION 17
- (Topic 3)
In what order are Access Controls evaluated?

A. Field-level - mast general to most specific: then Row-level - most specific to most general
B. Table-level - most specific to most general; then Row-level - most specific to most general
C. Table-level - most specific to most general; then Field-level « most specific to mast general
D. Field-level - most specific to most general: then Table-level - most specific to most general

Answer: D

NEW QUESTION 20
- (Topic 3)
On the Cl Dependency View, what enables you to trace from an infrastructure item, like a Server, to the Services that are dependent on that Server?

A. Service Tracer
B. Automapping Utility
C. Relationships
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D. Transform Map

Answer: C

NEW QUESTION 25
- (Topic 3)
For your implementation, the following tables. are extended fram each ofher:
* Incident table is extended from Task table.
* Super Incident table is extended from Incident table,
In this situation, which table(s) are P arent, Child and Base tables? Choose 5 answers

A. Incident table is a Base table
B. Incident table i
C. a Parent table
D. Incident table is a Child table
E. Super Incident table is a Child table
F. Super Incident table is a Parent table
G. Super Incident table is a Base table
H. Task table is a Base table
I. Task table is a Parent table
J. Task table is a Child table

Answer: BCDGH

NEW QUESTION 30
- (Topic 3)
When importing data from a spreadsheet, which step defines where the incoming data columns will be written in the receiving table?

A. Field Matching
B. Load Data
C. Select Data Source
D. Schedule Transform
E. Create Transform Map

Answer: E

Explanation: 
 A transform map is a set of field maps that define the relationships between fields in an import set and fields in an existing table1. When importing data from a
spreadsheet, creating a transform map is the step that defines where the incoming data columns will be written in the receiving table2. The transform map allows
users to specify how to transform the source data into the target data, such as by using scripts, coalescing, or mapping assist1.
References
? Transform Maps - Product Documentation: San Diego - ServiceNow1
? Importing Data: Excel to ServiceNow - Finite Partners2

NEW QUESTION 31
- (Topic 3)
When using Flow Designer what is the Flow Execution initiated by?

A. A trigger
B. An existing subflow
C. Allow logic
D. An execution data pill

Answer: A

Explanation: 
 A trigger is an activity that, once specified, automatically initiates a flow1. A trigger specifies the conditions that start running the flow, such as creating a record in
a specified table, receiving an inbound email, or reaching an SLA target1.
References
? Flow trigger types - Product Documentation: San Diego - ServiceNow1

NEW QUESTION 32
- (Topic 3)
A new employee joins the IT deployment and needs to perform work assigned to Network and Hardware groups. How would you set up their access?
Choose 3 answers

A. Add User Account to itll group
B. Add User Account to ACL
C. Add User Account to network group
D. Add User Account to IT Knowledgebase
E. Create User Account
F. Add User Account to Hardware group

Answer: BCF

NEW QUESTION 37
- (Topic 3)
What section on the notes tab, shows the history of the work documented on the record?
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A. Journal
B. Activity
C. Diary
D. Audit Log
E. Timeline

Answer: B

NEW QUESTION 42
- (Topic 3)
Tables may have a One to Many relationships. From the Service Catalog, what are examples of tables having a one to many relationships? (Choose three.)

A. One Approval can have many Requests
B. One Request can have many Requested Items
C. One Requested Item can have many Approvals
D. One Requested Item can have many Catalog Tasks
E. One Cart can have many Requests

Answer: BDE

NEW QUESTION 44
- (Topic 3)
On Access Control Definitions, what are ways you can set the permissions on a Table? Choose 3 answers

A. Groups
B. CRUD
C. Roles
D. Script that sets the answer variable to true or false
E. Conditional Expressions

Answer: CDE

NEW QUESTION 48
- (Topic 3)
Which action enables personalization in a form for the admin role, only?

A. Navigate to sys_form_properties.list and set the property glide.ui.enable_personalize_form.admin to true.
B. Navigate to Context Menu > Configure > Form Layout and select 'Enable Personalization' and Enter the 'admin' role.
C. Navigate to Context Menu > Configure > Table and add the role 'Admin' in the 'Available User' list box.
D. Navigate to sys_properties.list find the property glide.ui.personalize_form.role and set the Value to admin.

Answer: D

Explanation: 
 This action allows only users with the admin role to personalize forms by using the Personalize Form button1. The other options are either invalid or do not restrict
personalization to the admin role only.
ReferencesPersonalize a formUI settings and personalizationPersonalization

NEW QUESTION 53
- (Topic 3)
On a Business Rule, the When salting determines at what point the rule executes. What are the options for specifying that timing?

A. Insert, Update, Delet
B. Query
C. 4G} Before, After, Async, Display
D. Prior to, Synchronous, on Update
E. Before, Synchronous, Scheduled Job, View

Answer: B

NEW QUESTION 56
- (Topic 3)
Tables may be set up with Many to Many relationships. What is a classic example of a scenario where the tables would have many to many relationships?

A. Requests can contain many items; and Items can be any item from the catalog.
B. Vendors can sell multiple products; and products can be sold by multiple vendors.
C. A Task can trigger many Workflows; and a Workflow can trigger many Tasks
D. A Configuration Item can belong to multiple Classes; and Classes can contain multiple Configuration Items.

Answer: B

NEW QUESTION 60
- (Topic 3)
What is the result of the order in which access controls are evaluated?

A. Ensures user has access to the fields in a table, before considering their access to the table
B. Ensures user can get to work as quickly as possible
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C. Ensures user has access to the application, before evaluating access to a module within the application
D. Ensures user has access to a table, before evaluating access to a field in the table

Answer: D

Explanation: 
Reference: https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0541355

NEW QUESTION 61
- (Topic 3)
An IT user calls the service desk because they need to work on task records. All they can see is Self Service on their homepage when they login to the
ServiceNow instance. What issue could explain this? Choose 2 answers

A. Their user account failed LDAP authentication
B. Their user account is not logged in properly
C. Their user account was not approved by their manager
D. Their user account does not have itil role
E. Their user account does not belong to any groups, which contain the itil role

Answer: AC

NEW QUESTION 63
- (Topic 3)
Which set of steps is used to import spreadsheet data into a ServiceNow table?

A. Load Data, Create Transform Map, Run Transform
B. Select Import Set, Select Transform Map, Run Transform
C. Select Data Source, Schedule Transform
D. Define Data Source, Select Transform Map, Run Transform

Answer: A

Explanation: 
 These are the steps to import spreadsheet data into a ServiceNow table, as explained in the official documentation1 and the video tutorial2. The other options are
either incomplete or incorrect.
References1: Import a spreadsheet - Product Documentation: Utah - Now Support Portal2: How To Import Data Into ServiceNow - YouTube

NEW QUESTION 67
- (Topic 3)
You have heard about a new application released by SericeNow, You want to try it out, to- see if it might be useful for your company's ServiceNow implementation.
What would be the best way to get hands-on experience with the new application?

A. Check the latest release notes at docs.servicenow.com.
B. Activate the application plug in, on your personal dev instance.
C. Search the wiki for the sales demo request form,
D. Activate the application plug in, on your company's production instance.

Answer: B

NEW QUESTION 68
- (Topic 3)
What are advantages of using spokes for integrations? Choose 3 answers

A. Reduces the need for code
B. Features scale and control mechanisms
C. Free spokes are available in the ServiceNow Store
D. Ensures discoverability and reuse
E. Automated event management

Answer: ADE

NEW QUESTION 71
- (Topic 3)
On a form, which type of Geld has this icon which can be clicked, 10 S00 a preview of the associated record?

The Leader of IT Certification visit - https://www.certleader.com



100% Valid and Newest Version CSA Questions & Answers shared by Certleader
https://www.certleader.com/CSA-dumps.html (371 Q&As)

A. Drilkdown
B. Lookup
C. Quickview
D. Preview
E. Snapshot
F. Reference:

Answer: F

NEW QUESTION 73
- (Topic 3)
A customer wants to be able to identify and track components of their infrastructure that support their ecommerce service. What ServiceNow products could
support this
requirement? Choose 3 answers

A. Performance Analytics
B. Configuration Management (CMDB)
C. Financial Management
D. Discovery
E. Service Mapping

Answer: BDE

Explanation: 
 Configuration Management (CMDB) is a product that allows users to identify and track components of their infrastructure, such as servers, applications,
databases, networks, and devices, and their relationships1. CMDB provides a single source of truth for IT assets and services, and supports IT service
management processes1.
Discovery is a product that automatically scans the network and populates the CMDB with the discovered infrastructure components and their attributes2.
Discovery uses probes, sensors, and patterns to identify and classify IT assets, and updates the CMDB with any changes2.
Service Mapping is a product that creates a top-down view of the infrastructure components that support a specific business service, such as ecommerce3.
Service Mapping uses discovery data and application traffic analysis to map the dependencies and relationships between IT assets and services, and displays
them in a graphical interface3. References
? Configuration Management Database (CMDB) - ServiceNow1
? Discovery - ServiceNow2
? Service Mapping - ServiceNow3

NEW QUESTION 75
- (Topic 3)
Which type of scripts run in the browser?

A. Policies and Client Scripts
B. Access Contral Scripts
C. script Include Scripts
D. Business Rule Scripts

Answer: A

NEW QUESTION 78
- (Topic 3)
What icon do you use to change the icon and color on a Favorite’?

A. Star
B. Triangle
C. Pencil
D. Clock

Answer: C

NEW QUESTION 81
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- (Topic 3)
What is the best practice related to using the Default Update Set for moving customizations between instances?

A. Merge Default update sets before moving between instances
B. Submit Default update set to application repository
C. You should not use the Default Update sets for moving between instances
D. Keep Default update set to maximum of 20 records, for troubleshooting purposes

Answer: C

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-application-development/page/build/system-update-sets/reference/default-update-sets.html

NEW QUESTION 84
- (Topic 3)
When an administrator sets a policy that is applied to all data entered into the Platform (UI, Import Sets, or Web Services), where does this policy run by default?

A. Network
B. Server
C. Client
D. Browser

Answer: B

Explanation: 
 A policy that is applied to all data entered into the Platform is called a Data Policy. Data policies run on the server side and enforce data consistency by setting
mandatory and read-only states for fields1.
ReferencesData policies

NEW QUESTION 88
- (Topic 3)
What component of the ServiceNow infrastructure defines every table and field in the system?

A. Data Atlas
B. Table Class Manager
C. Schema
D. Dictionary
E. Field Map

Answer: D

NEW QUESTION 90
- (Topic 3)
How is a user defined in ServiceNow?

A. user is a record stored in the User Preference [Sys_user_preference] table
B. A User is a record stored in the Profile [sys_user_profile] table
C. A user is 2 field in the LOAP integration
D. A user is a record stored in the User [sys_user] table

Answer: A

NEW QUESTION 91
- (Topic 3)
The testing team needs to be able to perform activities in the test instance, as though they
are a member of the Service Desk group. What role would they need to be able to switch between user accounts, without logging out and back in?

A. service_desk
B. impersonator
C. admin
D. incognito

Answer: B

Explanation: 
The impersonator role allows a user to switch to another user account and act as that user without logging out and back in1. This can be useful for testing
purposes or for providing support to other users2.
ReferencesImpersonate a userRoles and permissions

NEW QUESTION 93
- (Topic 3)
Access Control rules are applied to a specific table, like the Incident table. What is the object name for a rule that applies to the entire Incident table (all rows and
fields)?

A. incident .*
B. incident.all
C. incident .!
D. incident.None
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Answer: A

Explanation: 
 The object name for a rule that applies to the entire Incident table is incident
.* , which means any field on the incident table. The other options are not valid object names for access control rules.
ReferencesAccess control list rulesAccess Control List in ServiceNowAccess Controls

NEW QUESTION 94
- (Topic 3)
After you create a new table, what is the best practice regarding the navigation pane? Choose 2 answers

A. Set the filter condition on the Application Menu
B. Set the font style on both the Application Menu and the Module
C. Specify which Roles are able ta see the Module
D. Specify which Roles are able to see the Application Menu
E. Create Application Menu with the same name as the table label
F. Create Module with the plural of the table label

Answer: CD

NEW QUESTION 99
- (Topic 3)
Which ServiceNow utility provides a modern interactive graphical interface to visualize
configuration items and their relationship?

A. CSDM Schema
B. Business Service Map
C. Dependency View
D. CI Class Map

Answer: D

NEW QUESTION 103
- (Topic 3)
A customer requests the following data quality measures be added:
* 1. Incident numbers should be read-only on all lists and forms, for all users.
* 2. Short Description field should be mandatory, on all records, across all applications, on insert.
Which type of policy would you use to meet this requirement?

A. Data policy
B. Dictionary Design Policy
C. Data Quality Policy
D. Field Criteria Policy

Answer: A

NEW QUESTION 107
- (Topic 3)
What is the most common role that has access to almost all platform features, functions, and data?

A. Security Admin [security_admin]
B. Sys Admin [sys_admin]
C. Admin [sn_admin]
D. System Administrator [admin]
E. Base Admin [base_admin]

Answer: C

Explanation: 
Reference: https://developer.servicenow.com/dev.do#!/guides/quebec/now-platform/glossary/developer-glossary

NEW QUESTION 110
- (Topic 3)
Which data consistency settings can be achieved using UI Policy? Choose 3 answers

A. Setting fields to accept the data with ‘n’ number of characters
B. Setting fields hidden
C. Setting fields to accept the data in an expected format
D. Settings fields read-only
E. Setting fields mandatory

Answer: BDE

NEW QUESTION 112
- (Topic 3)
What is used to determine user access to knowledge bases or a knowledge article?
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A. sn_kb_read, sn_article_read
B. Privacy Settings
C. Read Access Flag
D. User Criteria

Answer: D

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/product/knowledge-management/concept/user-access-knowledge.html

NEW QUESTION 117
- (Topic 3)
Which tab on the knowledge base record, would you use to identify the sets of users who are able to read articles in that knowledge base?

A. Access List
B. Can Access
C. Accessible to
D. Can Read

Answer: D

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/product/knowledge-management/task/t_SelectUserCriteria.html

NEW QUESTION 119
- (Topic 3)
Which testing framework is used to test ServerNew Applications?

A. Selenium
B. Test Driven Framework (TDF)
C. Junit
D. Automated test Framework (ATF)

Answer: D

NEW QUESTION 120
- (Topic 2)
When creating a global custom table named “abc”, what is the table name that is automatically assigned by the platform?

A. snc_abc
B. abc
C. u_abc
D. sys_abc

Answer: C

NEW QUESTION 121
- (Topic 2)
On a Business Rule, the When setting determines at what point the rule executes. What are the options for specifying that timing?

A. Before, After, Async, Display
B. Prior to, Synchronous, on Update
C. Insert, Update, Delete, Query
D. Before, Synchronous, Scheduled Job, View

Answer: A

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-application-development/page/script/business-rules/reference/r_HowBusinessRulesWork.html

NEW QUESTION 126
- (Topic 2)
Which ServiceNow resource is a framework that ensures the data your ServiceNow application requires maps correctly to the appropriate CMDB tables?

A. Common Service Data Model (CSDM)
B. Service Mapping Utility (SMU)
C. Service Schema Map (SSM)
D. CMDB Class Manager (CMDBCM)
E. CI Class Manager (CICM)

Answer: A

Explanation: 
Reference: https://docs.servicenow.com/bundle/paris-servicenow-platform/page/product/csdm-implementation/concept/csdm-basics.html

NEW QUESTION 131
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- (Topic 2)
Which core table in the ServiceNow platform provides a series of standard fields used on each of the tables that extend it, such as the Incident [incident] and
Problem [problem] tables?

A. Task [task]
B. Assignment [assignment]
C. Service [service]
D. Workflow [workflow]

Answer: A

NEW QUESTION 135
- (Topic 2)
What is a key difference between Reporting and Performance Analytics?

A. Performance Analytics contains snapshots of data taken over time; Reporting shows only the data as it is, at the moment the report is run.
B. Performance Analytics can show trends; Reports cannot.
C. Reports can be run on a scheduled basis; Performance Analytics cannot.
D. Performance Analytics data can be published to Dashboards; Reports cannot.
E. Performance Analytics shows KPIs; Reporting does not.

Answer: B

NEW QUESTION 138
- (Topic 2)
When you need to orchestrate business processes across services with little technical user knowledge, which utility would you use?

A. Flow Manager
B. Flow Designer
C. Flow Editor
D. Workflow Editor
E. Workflow Designer

Answer: C

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/product/orchestration/reference/r-orchestration-introduction.html

NEW QUESTION 141
- (Topic 2)
What are the three permission requirements that must evaluate to true for an access control rule to apply?
Choose 3 answers

A. Conditions
B. table.
C. Roles
D. Script
E. table."
F. table.none

Answer: CDE

NEW QUESTION 145
- (Topic 2)
What is a quick way to create a report from a list view?

A. Click on filter breadcrumb, drag and drop on the Report > Create New module
B. Click Funnel, define filter conditions, click Create Report
C. Click Context Menu, select Create Report
D. Apply filter, right click on column header, select Bar Chart
E. Apply filter, right click on column header, select Create Report

Answer: B

Explanation: 
Reference: https://ut.service-now.com/sp?id=kb_article&number=KB0014148

NEW QUESTION 147
- (Topic 2)
While showing a customer their incident form, they ask to change the Priority values to display their internal terminology P1, P2, P3, P4. They want it to be
consistent across all Tasks. How would you do that?
Right click on Priority and select what?

A. Configure Lists
B. Show Options
C. Configure Task
D. Show Choices
E. Show Choice List
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F. Configure Options

Answer: F

NEW QUESTION 148
- (Topic 2)
How is a group defined in ServiceNow?

A. A group is one record stored in the Group Type [sys_user_group_type] table
B. A group is one record stored in the Group [sys_user_group] table
C. A group defines a set of users that share the same location
D. A group defines a set of users that share the same job title

Answer: B

NEW QUESTION 149
- (Topic 2)
What is a no-code approach to control the mandatory or read-only state of a form field?

A. UI Action
B. Client Script
C. UI Script
D. UI RuIe
E. UI Policy

Answer: E

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/field-administration/concept/c_DataPolicy.html

NEW QUESTION 151
- (Topic 2)
New records, new groups, and modified configuration Items (Cls): what do they have in common?

A. They are included in an Update Set
B. They are not captured in an Update Set
C. They are customizations
D. They do not have anything in common

Answer: A

NEW QUESTION 154
- (Topic 2)
When does the Submit button appear on a form?

A. When saving an old record
B. When creating a new record
C. When changing the reference field in an existing record
D. When updating an existing record

Answer: B

NEW QUESTION 159
- (Topic 2)
You are showing your customer a new form that you have created for their new application. They would like to add a field to the form. Where could you do that?
(Choose two.)

A. Select Fields and Columns module
B. Right click on form header, select Configure > Form Layout
C. Click on context menu, select Configure > Form Designer
D. Select Field Class Manager module

Answer: BC

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-it-service-management/page/product/change-management/task/t_CreateCustomField.html

NEW QUESTION 160
- (Topic 2)
What is specified in an Access Control rule?

A. Groups, Conditional Expressions and Workflows
B. Table Schema, CRUD, and User Authentication
C. Object and Operation being secured; Permissions required to access the object
D. security_admin
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Answer: C

Explanation: 
Reference: https://www.servicenowelite.com/blog/2019/10/2/access-controls#:~:text=An%20instance%20uses%20access%20control,object%20and%20operati
on%20being%20secured

NEW QUESTION 165
- (Topic 2)
When impersonating a user for testing purposes, what is the best way to return the instance, logged in with your user account?

A. Turn your computer off and on again
B. Clear browser cache
C. End Impersonation
D. Log out and back in

Answer: D

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/users-and-groups/concept/c_ImpersonateAUser.html

NEW QUESTION 170
- (Topic 2)
What do you call any component that needs to be managed in order to deliver services?

A. CSDM Items
B. CMDB
C. Configuration item
D. Service Offerings
E. Asset

Answer: C

Explanation: 
Reference: https://infocenter.io/servicenow-cmdb-implementation/

NEW QUESTION 172
- (Topic 2)
What is used frequently to move customizations from one instance to another?

A. Update Sets
B. Code Sets
C. Update Packs
D. Configuration Logs
E. Remote Sets
F. Local Sets
G. Code Packs

Answer: A

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-it-operations-management/page/product/service-mapping/task/export-patterns.html

NEW QUESTION 177
- (Topic 2)
As an IT employee what interface would you use, if you wanted to browse internal IT documentation, like troubleshooting scripts and FAQs?

A. Knowledge
B. ServiceNow Wiki
C. Knowledge Now
D. SharePoint
E. Stack Overflow

Answer: A

Explanation: 
Reference: https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0547260

NEW QUESTION 182
- (Topic 2)
What would NOT appear in the Application Navigator if “service” is typed into the filter field?

A. Configuration > Business Services
B. Self-Service > Knowledge
C. Service Portal > Widgets
D. Incident > Assigned to me

Answer: D
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NEW QUESTION 185
- (Topic 2)
Which one of the following is an accurate list of changes that are captured in an Update Set?

A. Changes made to tables, forms, schedules, and client scripts
B. Changes made to tables, forms, views, and fields
C. Changes made to: tables, form
D. Business Rules, and data records
E. Changes made to: table
F. forms groups, and configuration items (Cls)

Answer: A

NEW QUESTION 190
- (Topic 2)
Your customer would like to create a new template to notify users who are affected by network outages at their site. Which module would you use to create a new
notification?

A. System Notification > Email > Notifications
B. Administration > Notification Overview
C. System Properties > Email > Settings
D. User Preferences > Email > Notifications
E. Click Gear > Notifications > New

Answer: A

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/administer/notification/task/t_CreateANotification.html

NEW QUESTION 194
- (Topic 2)
Which of the following statements describes how data is organized in a table?

A. A column is a field in the database and a record is one user
B. A column is one field and a record is one row
C. A column is one field and a record is one column
D. A column contains data from one user and a record is one set of fields

Answer: A

NEW QUESTION 198
- (Topic 2)
How are local flow variables accessed in the Flow Designer Data panel?

A. As newly generated icons
B. As scratchpad variables
C. As new tabs
D. As data pills

Answer: D

NEW QUESTION 203
- (Topic 2)
Which section of the ServiceNow UI allows you to perform a global search?

A. Application Navigator
B. Banner frame
C. List pane
D. Content frame

Answer: B

NEW QUESTION 204
- (Topic 2)
What are different types of Data Sources, which may be imported into ServiceNow? (Choose four.)

A. Local Sources (i.
B. XML, CSV, Excel)
C. Implementation Spoke
D. DataHub
E. JDBC Connection
F. Network Server
G. LDAP Connection

Answer: ACDF

Explanation: 
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Reference: https://developer.servicenow.com/dev.do#!/learn/learning-plans/quebec/servicenow_administrator/app_store_learnv2_importingdata_quebec_data_s
ources

NEW QUESTION 207
- (Topic 2)
A new Service Desk employee in Latin America complains that the create dates and times are incorrect on their Incident list. What would you suggest to fix this
issue?

A. Have them clear their cache.
B. Have them use the gear icon to set the employee’s time zone.
C. Recommend they use Chrome, instead of Explorer.
D. Use the system properties to correct the instance’s time zone.
E. Have them correct the time zone on their computer.

Answer: E

Explanation: 
Reference: https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0659171

NEW QUESTION 212
- (Topic 2)
Which of the following steps can be used to import new data into ServiceNow from a spreadsheet?

A. Select Data Source, Schedule Transform
B. Load Data, Create Transform Map, Run Transform
C. Define Data Source, Select Transform Map, Run Transform
D. Select Import Set, Select Transform Map, Run Transform

Answer: D

NEW QUESTION 216
- (Topic 2)
Which module is used as the first step for importing data?

A. Coalesce Data
B. Transform Data
C. Import Data
D. Load Data

Answer: D

Explanation: 
Reference: https://docs.servicenow.com/bundle/paris-platform-administration/page/administer/import-sets/concept/c_ImportDataUsingImportSets.htm

NEW QUESTION 218
- (Topic 2)
When designing a flow, how do you reference data from a record, in that flow?

A. Drag the table icon onto the flow definition
B. Use the condition builder to specify the desired values
C. Specify the source table on the data pill related list
D. Drag the data pill onto the flow definition
E. Add the table reference using the slush bucket

Answer: D

Explanation: 
Reference: https://developer.servicenow.com/dev.do#!/learn/learning-plans/paris/citizen_developer/app_store_learnv2_flowdesigner_paris_using_flow_variables

NEW QUESTION 219
- (Topic 2)
Which ServiceNow capability provides assistance to help users obtain information, make decisions, and perform common work tasks via a messaging interface?

A. Agent Workspace
B. Chat bot
C. Virtual Agent
D. Knowledge Chat
E. Now Support

Answer: C

NEW QUESTION 224
- (Topic 2)
How can administrators utilize the same content for different notification channels?

A. Configure Default notification content
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B. Enable Actionable notification content
C. Provide Common notification content
D. Set up Related notification content

Answer: C

NEW QUESTION 226
- (Topic 2)
Which of the following protects applications by identifying and restricting access to available files and data?

A. Application Configuration
B. Verbose Log
C. Access Control Rules
D. Application Scope

Answer: D

NEW QUESTION 230
- (Topic 1)
database live at the Data Center.

A. True
B. False

Answer: A

NEW QUESTION 231
- (Topic 2)
Which tool is used to define relationships between fields in an import set table and a target table?

A. Transform Schema
B. Schema Map
C. Dictionary Map
D. Transform Map
E. Field Transformer
F. Import Designer

Answer: D

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/import-sets/concept/c_ImportSetsKeyConcepts.html

NEW QUESTION 232
- (Topic 1)
The baseline Service Catalog homepage contains links to which of the following components?

A. Record Producers, Order Guides, and Catalog Items
B. Order Guides, Item Variables, and Workflows
C. Order Guides, Catalog Items, and Workflows
D. Record Producers, Order Guides, and Item Variables

Answer: A

NEW QUESTION 234
- (Topic 1)
A User is stored in which table?

A. User [sys_user]
B. User [ sys_user_group]
C. User [ syst_user_profile]
D. User [user_profile]

Answer: A

NEW QUESTION 235
- (Topic 1)
There are _____ common types of Interfaces (Numeric Value) 6: There are six common types of interfaces

A. Homepage: Consists of navigational elements, functional controls, and platform information.
B. List: Display records from a data table, as well as allow you to edit the record information using the List Editor functionally.
C. Form: Data is entered into ServiceNow through forms
D. Dashboard: Enable you to display multiple performance analytics, reporting and other widgets on a single screen.
E. Maps: Display ServiceNow data graphically on a Google map
F. Timelines: Used to track tasks or projects

Answer: C
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NEW QUESTION 238
- (Topic 1)
Which one of the following statements describes the purpose of a Service Catalog workflow?

A. A Service Catalog workflow generates three basic components: item variable types, tasks, and approvals
B. Although a Service Catalog workflow cannot send notifications, the workflow drives complex fulfillment processes
C. A Service Catalog workflow is used to drive complex fulfillment processes and sends notifications to defined users or groups
D. A Service Catalog workflow generates three basic components: item variable types, tasks, and notifications

Answer: C

NEW QUESTION 243
- (Topic 1)
What is a way that you can mark a knowledge article for review?

A. Flag article
B. Review
C. Bookmark
D. On Hold

Answer: A

NEW QUESTION 245
- (Topic 1)
Which one of the following statements best describes the purpose of an Update Set?

A. An Update Set allows administrators to group a series of changes into a named set andthen move this set as a unit to other systems
B. By default, an Update Set includes customizations, Business Rules, and homepages
C. An Update Set is a group of customizations that is moved from Production to Development
D. By default, the changes included in an Update Set are visible only in the instance to which they are applied

Answer: A

NEW QUESTION 246
- (Topic 1)
What is generated from the Service Catalog once a user places an order for an item or service?

A. A change request
B. An Order Guide
C. A request
D. An SLA

Answer: C

NEW QUESTION 247
- (Topic 1)
Which group of permissions is used to control Application and Module access?

A. Access Control Rules
B. UI Policies
C. Roles
D. Assignment Rules

Answer: C

NEW QUESTION 250
- (Topic 1)
What is the path an Administrator could take to view the fulfillment stage task list for an order placed by a user?

A. RITM (Number)>REQ (Number)>PROCUREMENT (Number)
B. REQ (Number)>RITM (Number)>PROCUREMENT (Number)
C. REQ (Number)>RITM (Number)>TASK (Number)
D. FULFILLMENT (Number)>RITM (Number)>TASK (Number)

Answer: C

NEW QUESTION 251
- (Topic 1)
Knowledge articles within a knowledge base are grouped by category.

A. True
B. False

Answer: A
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NEW QUESTION 255
- (Topic 1)
Where would you go in ServiceNow to order services and products offered by various departments?

A. Service Catalog
B. Self Service
C. Service Department
D. Customer Service

Answer: A

NEW QUESTION 257
- (Topic 1)
What refers to an application or system that accesses a remote service or another computer system, known as a server?

A. Server
B. Client
C. Script
D. Policies

Answer: B

NEW QUESTION 259
- (Topic 1)
Which of the following can be customized through the Basic Configuration UI 16 module? (Choose three.)

A. Banner Image
B. Record Number Format
C. Browser Tab Title
D. System Date Format
E. Form Header Size

Answer: ACD

NEW QUESTION 261
- (Topic 1)
What is the name of the conversational bot platform that provides assistance to help users obtain information, make decisions, and perform common tasks?

A. Agent
B. live Feed
C. Virtual Agent
D. Connect Chat

Answer: C

NEW QUESTION 266
- (Topic 1)
Each knowledge bases can have unique lifecycle workflows, user criteria, category structures, and management assignments.

A. True
B. False

Answer: A

NEW QUESTION 270
- (Topic 1)
Which term best describes something that is created, has worked performed upon it, and is eventually moved to a state of closed?

A. report
B. workflow
C. event
D. task

Answer: D

NEW QUESTION 271
- (Topic 1)
Which one of the following modules can be used to view field settings for a table?

A. Tables & Columns
B. Access Control
C. Columns and Fields
D. Tables and Fields

Answer: A
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NEW QUESTION 272
- (Topic 1)
Which one of the following statements is a recommendation from ServiceNow about Update Sets?

A. Avoid using the Default Update set as an Update Set for moving customizations from instance to instance
B. Before moving customizations from instance to instance with Update Sets, ensure that both instances are different versions
C. Use the Baseline Update Set to store the contents of items after they are changed the first time
D. Once an Update Set is closed as “Complete”, change it back to “In Progress” until it is applied to another instance

Answer: A

NEW QUESTION 273
- (Topic 1)
Buttons, form links, and context menu items are all examples of what type of functionality?

A. Business Rule
B. UI Action
C. Client Script
D. UI Policy

Answer: B

NEW QUESTION 274
- (Topic 1)
Which statement is true about business rules?

A. A business rule must run before a database action occurs
B. A business rule can be a piece of Javascript
C. A business rule must not run before a database action occurs
D. A business rule monitors fields on a form

Answer: B

NEW QUESTION 275
- (Topic 1)
A REQ number in the Service Catalog represents…

A. the order number.
B. the stage.
C. the task to complete.
D. the individual item in the order.

Answer: A

NEW QUESTION 280
- (Topic 1)
Which one of the following statements describes a characteristic of role assignment?

A. Roles can contain other roles, when you are assigned a role, you inherit all the roles within that role
B. Users can click on the Personalize Role feature to try different roles
C. A role is granted to a user by the System Administrator
D. Each user has a role in the ServiceNow platform

Answer: A

NEW QUESTION 283
- (Topic 1)
Which of the following are a type of client scripts supported in ServiceNow? (Choose four.)

A. onSubmit
B. onUpdate
C. onCellEdit
D. onLoad
E. onEdit
F. onChange
G. onSave

Answer: ACDF

NEW QUESTION 288
- (Topic 1)
Access Control rules may be defined with which of the following permission requirements? (Choose three.)

A. Roles
B. Conditional Expressions
C. Assignment Rules
D. Scripts
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E. User Criteria
F. Groups

Answer: ABD

NEW QUESTION 290
- (Topic 1)
Create Incident, Password Reset, and Report outage: what do these services in the Service Catalog have in common?

A. They direct the user to a record producer
B. They direct the user to a catalog property
C. They direct the user to a catalog UI policy
D. They direct the user to a catalog client script

Answer: A

NEW QUESTION 295
- (Topic 1)
What is the platform name for the User table?

A. u_users
B. sys_users
C. x_users
D. sys_user

Answer: D

NEW QUESTION 299
- (Topic 1)
What are the three components of a filter condition?

A. Table
B. Value
C. Field
D. Operator

Answer: BCD

NEW QUESTION 300
- (Topic 3)
A task worker asks how they can monitor any updates occurring to recands assigned to him, like responses from customers, What do you suggest?

A. Open an Agent workspace tab for each record he wants to monitor
B. Select Service Desk > My Work Dashboard
C. Click on the eyeglass icon t
D. expand the Monitor frame
E. On My Work list, select the Activity Stream icon to show a frame with live updates

Answer: D

NEW QUESTION 302
- (Topic 3)
On a form header, what icon would you click to access Template features?

A. Paper clip
B. More options (...)
C. Stamp
D. Context Menu

Answer: B

NEW QUESTION 307
- (Topic 3)
Which role(s) are required to impersonate a user? Choose 2 answers

A. admin
B. sys_admin
C. security_admin
D. sys_user
E. impersonator

Answer: AE

Explanation: 
 The admin role is required to impersonate any user in ServiceNow, while the impersonator role is required to impersonate a user who has granted impersonation
access to the impersonator. The other roles are not related to the impersonation functionality. References1: Impersonate a user - Product Documentation: San
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Diego - ServiceNow2: Non-admin users with the “impersonator” role cannot impersonate any user if there are orphaned ‘sys_user_has_role’ records like " [user:
null; role: admin]". - Support and Troubleshooting - ServiceNow

NEW QUESTION 312
- (Topic 3)
What would you do, on a list, if you wanted to show the records in groups, based on the column category? (Choose two.)

A. On list Context Menu, select Group By > Category
B. On the Filter Menu, select Group By > Category
C. Click Group On icon, select Category
D. On Navigator Filter, type tablename.group.category and press enter
E. On the Category column title, click Context menu > Group By Category

Answer: AE

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/use/using-lists/concept/c_GroupedLists.html

NEW QUESTION 315
- (Topic 3)
What is the platform name for the Group table?

A. SyS_USer_group
B. Sys_group
C. group
D. sys_groups

Answer: A

NEW QUESTION 318
- (Topic 3)
What table acts as a staging area for records imported from a data source?

A. Transform Table
B. Staging Table
C. Import Set Row Table
D. Temp Table

Answer: C

NEW QUESTION 322
- (Topic 3)
A department manager asks an analyst to build some reports. Where do you recommend the analyst start?

A. Report Dashboard > Create New
B. Reports > Getting Started
C. Performance Analytics > Reports
D. Self-Service > Reports
E. Reports > Create New

Answer: E

Explanation: 
Reference: https://kstate.service-now.com/kb_view.do?sysparm_article=KB12492

NEW QUESTION 323
- (Topic 3)
What feature allows, you to limit who is able to contribute or read knowledge within a knowledge base?

A. Categories
B. Roles
C. User Criteria
D. Groups

Answer: C

NEW QUESTION 328
- (Topic 3)
What setting allows users to view a Knowledge Base article even if the are not logged in?

A. The View All setting
B. The Allow role
C. The ESS role
D. The Public setting

Answer: C
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NEW QUESTION 331
- (Topic 3)
Which helps to visualize configuration items and their relationships?

A. Transform Map
B. Schema Map
C. Tables
D. Flow Design
E. Dependency View

Answer: E

Explanation: 
The Dependency View provides a visual representation of the relationships between configuration items (CIs) in ServiceNow. It allows you to see how CIs are
connected and how changes to one CI may impact others.
References:
? ServiceNow Product Documentation: Configuration item relationships in the CMDB
- https://docs.servicenow.com/bundle/vancouver-servicenow- platform/page/product/configuration-management/concept/c_CIRelationships.html
? ServiceNow Community: How to display dependencies for CIs in the Dependency
View - https://www.servicenow.com/community/service-management-forum/load- a-specific-dependency-view-map/m-p/410421

NEW QUESTION 334
- (Topic 3)
What are examples of UI Actions relating to forms?
Choose 3 answers

A. Form Context Menu
B. Form View
C. Form Buttons
D. Form Links.
E. Form Columns

Answer: ACD

NEW QUESTION 337
- (Topic 3)
What does Natural Language Query allow you to do on a list?

A. Automatically select a filter, based on keywords
B. Filter list by typing in a phrase
C. Predict the filter desired by the user
D. Speak to the condition builder
E. Set list filter, using audible commands

Answer: A

NEW QUESTION 340
- (Topic 3)
Which ServiceNow capability allows you to provide knowledge articles, via a conversational messaging interface?

A. Agent Assist
B. Virtual Agent
C. Now Messenger
D. Connect Agent

Answer: B

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-release-notes/page/release-notes/analytics-intelligence-reporting/virtual-agent-rn.html

NEW QUESTION 342
- (Topic 3)
When creating a new notification, what must you define? Choose 3 answers

A. What is the content of the notification
B. The associated knowledge base
C. Under what conditions is the notification sent
D. Who receives the notification
E. Settings for handling inactive user accounts

Answer: ACD

NEW QUESTION 346
- (Topic 3)
Which one of the following describes the primary operations performed against tables in the Service Now platform?

A. Create, Rate, Update, Delete
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B. Create, Read, Upload, Delete
C. Create, Read, Write, Delete
D. Capture, Rate, Write, Develop

Answer: C

NEW QUESTION 350
- (Topic 3)

You are editing a new incident record and would like the Save" Dutton to be located on the Form header. Which action would need to be taken for that button to
appear?

A. All > System Properties > Ul Properties > Turn on the glide.ui.advanced* property
B. Context Menu > Form Design > add the Save'' button
C. All > System Properties > Ul Properties > Turn on the Save" button
D. Context Menu > Form Layout > add the Save* button.

Answer: C

Explanation: 
 To add the Save button to the form header, users need to turn on the system property glide.ui.save_button, which enables the Save button on all forms1. Users
can navigate to All > System Properties > UI Properties and search for the property name, then set the value to true1. Alternatively, users can use the
sys_properties.list URL suffix and filter by the property name1.
References
? How to add or enable Save Button on all the forms across a Servicenow Instance - Support and Troubleshooting - Now Support Portal

NEW QUESTION 352
- (Topic 3)

An order from the Service Catalog has been placed. Two records in the Platform are
created as a result. Which two records are associated with tins newly ordered item? Choose 2 answers

A. A record of sc_task
B. A record of sc_req_llem table
C. A change record
D. An Incident record
E. A problem record

Answer: AB

NEW QUESTION 357
- (Topic 3)
Which feature can be used to categorize a set of records from a list and make them visible to other users?

A. Tags
B. History
C. Favorites
D. Activity Formatter

Answer: A

Explanation: 
 Tags are labels that you can apply to any task record in ServiceNow. You can use tags to categorize, filter, and search records. You can also share tags with
other users to make them visible to others1.
ReferencesUsing tags
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NEW QUESTION 359
- (Topic 3)
What does ServiceNow recommend as a best practice regarding data imports?

A. Adjust your Transform maps, after the data is loaded into the target table.
B. Use extremely large Import Sets, instead of multiple large Import Sets.
C. Create a new Import set table for each new data load.
D. Plan time before your import to remove obsolete or inaccurate data.
E. Monitor data quality and clean imported data, using the Data Scrub Workspace.

Answer: D

Explanation: 
 This is a best practice because it reduces the amount of data that needs to be imported, transformed, and stored in ServiceNow, and improves the data quality
and performance of the system1.
ReferencesImport and export resources page

NEW QUESTION 363
- (Topic 3)
When selecting the Target table for an import, which tables can you select? Choose 3 answers

A. Tables within the global scope
B. Tables within the existing application scope
C. Tables outside of ServiceNow
D. Tables which allow write access to other applications
E. Related tables, using Dot Walk

Answer: ABD

NEW QUESTION 367
- (Topic 3)
What are the steps for applying an update set to an instance?

A. Retrieve, Preview, Commit
B. Specify, Transform, Apply
C. Retrieve, Assess, Apply
D. Get, Test, Push
E. Pull, Review, Push

Answer: A

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-application-development/page/build/system-update-sets/hier-update-sets/concept/us-hier- overview.html#us-
hier-overview

NEW QUESTION 368
- (Topic 3)
When would you use the following steps?
* 1, Homepage Admin > Pages
* 2. Right click on Homepage record
* 3. Select Unioad Portal Page

A. To publish a Homepage to the Portal
B. To retire a Homepage
C. To delete a Homepage
D. o To add a Homepage to an update set

Answer: D

NEW QUESTION 372
- (Topic 3)
How would you describe the relationship between the incident and Task table?

A. Incident table has a many to many relationship with the Task table.
B. Incident table has a one to much relationship with the Task table.
C. Incident table is extended from task table.
D. incident table is related to the Task table via the INC number
E. incident table is a database view of the Task table

Answer: C

NEW QUESTION 377
- (Topic 3)
An IT user calls the service desk because his work needs to be completed on ask records. All he can see a Self Service on his homepage when he logs in to the
ServiceNow instance. What issue could explain this?
Choose 2 answers

A. His user account failed LDAP authentication
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B. His user account does not Belong to any groups, which contain the ITIL role
C. His user account was not approved by his manager
D. His user account does not have ITIL role
E. His user account Is not logged in properly

Answer: BE

NEW QUESTION 379
- (Topic 3)
What are the benefits of building flows using Flow Designer? Choose 3 answers

A. Supports easy integration with 3rd party systems
B. Provides IDE for complicated scripting
C. Provides natural-langauge descriptions of flow logic
D. Supports No-Code application development
E. Automatically populates SLA records
F. Provides built-in libraries /API for complex coding

Answer: ACD

Explanation: 
The following are the benefits of building flows using Flow Designer:
? C. Provides natural-language descriptions of flow logic: This allows users without programming experience to understand and modify flows, making them more
accessible to a wider range of users.
? D. Supports No-Code application development: Flow Designer provides a visual interface and pre-built actions that allow users to automate processes without
writing code. This can significantly reduce development time and effort.
? A. Supports easy integration with 3rd party systems: Flow Designer integrates with a variety of 3rd party systems through the Integration Hub, making it easy to
connect your ServiceNow instance to external applications.
Flow Designer offers a low-code/no-code approach to building automation, simplifies complex logic with natural language descriptions, and integrates seamlessly
with external systems.
References:
? ServiceNow Product Documentation: Exploring Flow Designer - https://docs.servicenow.com/bundle/sandiego-application-development/page/administer/flow-
designer/concept/flow-designer.html
? ServiceNow Community: Flow Designer vs Workflow - https://www.servicenow.com/community/developer-forum/what-are-the-advantages-and-disadvantages-
between-flow-designer/m-p/1407094

NEW QUESTION 383
- (Topic 3)
What resource can you use to view details of the tables and configuration items (CIs) associated with a particular use case?

A. Scenario Dashboard
B. CI Use Case Modeler
C. CMDB Use Case Modeler
D. Common Service Data Model (CSDM) product view

Answer: D

Explanation: 
Reference: https://docs.servicenow.com/bundle/quebec-servicenow-platform/page/product/csdm-implementation/reference/cmdb-use-case.html

NEW QUESTION 386
- (Topic 3)
Which allows the creation of a task-based record from Service Catalog?

A. Record Producers
B. UI Builder
C. Assignment Rule
D. Flow Designer
E. UI Actions=

Answer: D

NEW QUESTION 388
- (Topic 3)
How would you distinguish between a Base Class table and a Parent Class table?

A. Base Class tables always have tables extended from them, Parent tables do not have tables extended from them.
B. Base Class table is not extended from another tabl
C. Parent class tables may be extended from another table.
D. Extended tables can be extended from Parent tables or Base tables, but they cannot be extended from both.
E. Extended tables are always extended from Parent tables, Extended tables are usually extended from Base tables,

Answer: B

NEW QUESTION 393
- (Topic 3)
The Report Designer contains different sections for configuring your report. Which section is used to adjust the look of your report, including colors, files, and
legend layout?
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A. Format
B. Layout
C. Style
D. Configure

Answer: C

NEW QUESTION 394
- (Topic 3)
Groups are stored in what table?

A. Group [sys_user_group]
B. Group [sn_sys_user_group]}
C. User Group [user_groups]
D. User Groups [sn_user_groups]
E. Groups [sys_user_groups]

Answer: A

NEW QUESTION 399
- (Topic 3)
On a list, what does each row show?

A. A filter
B. A record
C. A table
D. A field

Answer: B

Explanation: 
 A list is a collection of records from a table. Each row in a list represents a record in that table1.
ReferencesIdentifying the view used on a list or formServiceNow: List Views for BeginnersHow Do I See A List Of Users And Their Roles In ServiceNow

NEW QUESTION 400
- (Topic 3)
What are benefits of assigning work tasks to a group, rather than to an individual? (Choose four.)

A. Group members can choose their tasks from My Groups Work
B. Groups can assign tasks to users based on on-call schedules
C. Site support members can pick tasks, based on Location
D. Groups can assign tasks to users based on skills
E. Group members can avoid tasks, which are nearing SLA breach
F. Groups can assign tasks to users based on availability

Answer: BCDF

NEW QUESTION 403
......

The Leader of IT Certification visit - https://www.certleader.com



100% Valid and Newest Version CSA Questions & Answers shared by Certleader
https://www.certleader.com/CSA-dumps.html (371 Q&As)

Thank You for Trying Our Product

* 100% Pass or Money Back

All our products come with a 90-day Money Back Guarantee.

* One year free update

You can enjoy free update one year. 24x7 online support.

* Trusted by Millions

We currently serve more than 30,000,000 customers.

* Shop Securely

All transactions are protected by VeriSign!

  

100% Pass Your CSA Exam with Our Prep Materials Via below:

https://www.certleader.com/CSA-dumps.html

Powered by TCPDF (www.tcpdf.org)

The Leader of IT Certification visit - https://www.certleader.com

https://www.certleader.com/CSA-dumps.html
http://www.tcpdf.org

